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INTRODUCTION

Purpose

This manual is a user’s guide for OfficeServ EasySet, the management program
concerned with the connection of PBX system.

This manual describes main functions, installation, all kinds of function settings,
and examples of usage of the OfficeServ EasySet.

This manual includes the phased description of program from the fundamental
understanding to the processes that shall be performed for the use of OfficeServ
EasySet. Besides, the configuration of this manual is useful for users to select and
read only the contents that they need to check. Before using the OfficeServ EasySet,
users need to be familiar with this manual. Keep the notices of this manual in mind
before installing or using the programs.

If you have any question or problem while using the programs of OfficeServ
EasySet, contact Authorised Samsung Reseller.

Document Content and Organization

This manual is composed of 3 chapters. Each chapter is summarized as follows:

CHAPTER 1. Insallation of OfficeServ EasySet

This chapter describes the general introduction of OfficeServ EasySet, installation
environment, installation procedures, and environment settings.

CHAPTER 2. Starting OfficeServ EasySet

This chapter describes the execution procedures for OfficeServ Link and
OfficeServ EasySet.

CHAPTER 3. Using OfficeServ EasySet

This chapter describes how to login and use the menus of OfficeServ EasySet.
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ANNEXA. FAQ

FAQ describes troubleshooting for problems which may occur while using
OfficeServ EasySet.

ABBREVIATION

The frequently used acronyms and their meanings in this manual are all collected.

Conventions

Page Il

The following special paragraphs are used in this document to point out information
that must be read. This information may be set-off from the surrounding text, but is
always preceded by a bold title in capital letters.

WARNING

WARNING

Provides information or instructions that the reader should follow in order to avoid
personal injury or fatality.

>

CAUTION

CAUTION

Provides information or instructions that the reader should follow in order to avoid a
service failure or damage to the system.

W

CHECK

CHECKPOINT

Provides the operator with checkpoints for stable system operation.

=
Q
=
m

NOTE

Indicates additional information as a reference.

r=

OPERATION PROCEDURES

Indicates the operational procedures that should be executed in sequence.
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Introduction

Console Screen Output

* The lined box with ‘Courier New’ font will be used to distinguish between

the main content and console output screen text.

* ‘Bold Courier New’ font will indicate the value entered by the operator
on the console screen.

Reference

OfficeServ Link User Guide

This manual is a user’s guide for Link, the management program concerned with
the connection of PBX system. This manual describes main functions, installation,
all kinds of function settings, and examples of usage of the Link.

Revision History

EDITION

DATE OF ISSUE

REMARKS

00

02. 2008.

First Edition
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SAFETY CONCERNS

For product safety and correct operation, the following information must be given
to the operator/user and shall be read before the installation and operation.

Symbols

A\

Caution

Indication of a general caution.

O

Restriction

Indication for prohibiting an action for a product.

Instruction

Indication for commanding a specifically required action.

/\ CAUTION

CAUTION

If a problem arises from the system when the OfficeServ EasySet is installed and a
re-installation of the operating system is needed, you must first backup the previous
data. Otherwise, you might lose all the previous data and also the settings of the
OfficeServ EasySet.
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CHAPTER 1
Installation of OfficeServ EasySet

This chapter describes the general introduction of OfficeServ EasySet, installation
environment, installation procedures and environment settings.

1  Overview of OfficeServ EasySet

OfficeServ EasySet enables a user to configure the keyset used at their PBX station
through a PC screen-based display, rather than by using the MMC(Man-Machine
Code) commands via the keyset keypad.

OfficeServ EasySet provides access to most system facilities and station
programming, and allows programmable buttons on the keyset to be programmed
via a GUI(Graphical User Interface) complete with help text.

The application itself resides on an 11S web server, which in turn is connected to the
PBX via the OfficeServ Link. The interface to the web server is via a Microsoft
Internet Explorer web browser user interface.

A user can manage their own keyset via menus by logging in using their internal
number after accessing the OfficeServ EasySet.

OfficeServ EasySet provides various functions that enable a user to set their
required features of a keyset.

Also, a user can easily view the information of their keyset through the OfficeServ
EasySet menus.

© SAMSUNG Electronics Co., Ltd. Page 1-1
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2 Installation Environment

Check the installation environment before installing the OfficeServ EasySet.
OfficeServ EasySet is to be installed on a PC that is able to communicate with the
OfficeServ Link to set and retrieve the settings on stations(keysets) attached to the
PBX.

The communication with the OfficeServ Link is via TCP/IP.

OfficeServ EasySet may be installed on the same PC as the OfficeServ Link, or
another PC communicating with the OfficeServ Link. The OfficeServ EasySet
software then provides information to the “clients’ via a web server(11S) on the
OfficeServ EasySet PC and the Internet Explorer browser on the “client’ PCs.

OfficeServ EasySet must be installed on a PC that has an operating system of
Microsoft Windows 2000 Professional or later, and with an 11S Web Service

provided.

To install and operate the OfficeServ EasySet, the minimum requirement
specifications for the system are given below:

Table 1.1 System specifications

Item Specifications
Computer CPU Intel P 111 800 MHz Minimum
Main Memory Above 256 MB Ram
oS Microsoft Windows 2000
Network TCP/IP protocol with a fixed IP address(not DHCP)
Web Server IIS(Internet Information Server)

Page 1-2 © SAMSUNG Electronics Co., Ltd.
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3.1

[ 1]
2]

Installation of OfficeServ EasySet
The installation procedures for OfficeServ EasySet are as follows:

1) Installation of the Web Service Program(11S)

2) Installation of the OfficeServ EasySet

3) Ifthe OS for the OfficeServ EasySet server is MS Windows XP and the file system
has been formatted as NTFS, some security options will have to be changed.

Installation of the Web Service Program (lIS)

The installation procedures for the Web Service Program(11S) are as follows:
The 11S setup program is included in the Windows Operating System.

1) In the taskbar, click [Start] > [Settings] > [Control Panel].
Select the [Add/Remove Programs] icon.

Windows Components Wizard il
Windows Components .
“fou can add o remove components of Windows 2000, 3
SRR

T add or remaove a companent, ciick the checkbos A chaded box means that oy
part of the component will be instaled. To see what's inchuded in a component, dick

Details,

Components:

b B Indesing Service 0oME =]
& VE Internet Infarmation Services [I15)

[ i] M anagement zmnd Moritoring Tools hZME

7] g Meszage Queding Senvices 2EMEB

[ 2=y W aharlkinn S eavinas IEME T

Descriptior: 115 services (Web and FTP suppoit] along with suppant for FrontPage,
tranzactons, ASPz. database connections, and receiving of posts.

Total disk space requred: 09 ME Dlestais
Space avalable on disk 23530 MB ;I

< Back | Mt > 1 Cancel |

o

Figure 1.1 Windows Components

2) From the Windows Components Wizard, click the [Add/Remove Windows
Components] button in the left-hand frame of the window. Then the Windows
Components Wizard window will be displayed as given below. After selecting
the ‘Internet Information Server(11S)’, click the [Next] button.

3) Ifan ‘Insert Disk’ message appears during the installation, insert the Windows
CD and click [OK]. Then click the [Browse] button and select the “i386° folder.

4) The installation will proceed as the program files are copied to the system.
Click the [Finish] button when the installation has completed.

© SAMSUNG Electronics Co., Ltd. Page 1-3
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3.2 Installation of OfficeServ EasySet

After setting the installation environment for the OfficeServ EasySet, install the
OfficeServ EasySet by following the steps as shown below:

CAUTION OfficeServ EasySet.

If a problem arises from the system when the OfficeServ EasySet is installed and a
re-installation of the operating system is needed, you must first backup the previous
data. Otherwise, you might lose all the previous data and also the settings of the

1) Execute the file ‘Setup.exe’. Then installation is started.
g2

OfficeSery EasySet - InstallShield Wizard

Preparing Setup

rest of the getup process. Pleage wait.

Fleaze wait while the Inztall5hield wizard prepares the setup.

OfficeSery EazySet Setup iz preparing the InstallShield wizard, which will guide vou through the

Cancel

Figure 1.2 Preparing Setup

2) When the window as shown below is activated, select a country.

OfficeSery EasySet Y3 Setup

Select Locale
Select the country that best suits your needs.

Page 1-4

Wwielcome to the InstallShield wizard for OfficeServ E agyset

The InstallShield[R fafizard will install OfficeSery Easpzet on pour computer. Select pour country
atd click Mext to continue.

An appropriate ELILA [End User License Agreement] will be displayed according to the country
o select.

Select Locale

Country:

[ Mest » ][ Cancel ]

© SAMSUNG Electronics Co., Ltd.
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Figure 1.3 Select Locale

4)  When the window as shown below is activated, click the [Yes] button to accept
the Licence Agreement conditions.

OfficeSery EasySet ¥3 Setup

License Agreement

Fleaze read the following license agreement carafully. I _h |

Press the PAGE DOWHN key to see the rest of the agreement.

Software Licerss Agreement & Limited W arranty A
For OfficeServ Easyset for iDCS Keyphone Series. =
Samszung Telecommunications America, L.P.

IMPORTANT. READ CAREFULLY:

This Samzung End-Uszer License Agreement [ELILA] iz 4 legal binding agreement between
youl [either an individual or an entity] and Samsung far Samsung software product
identified abave, which includes computer software and may include printed material, and o |

Do you accept all the terms of the preceding License Aareement? |f you select Mo, the setup
will cloge. Toinstall OfficeSery EazySet W3, you must accept this agreement.

Figure 1.4 License Agreement

© SAMSUNG Electronics Co., Ltd. Page 1-5
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5) When the window as shown below is activated, click the [Next] button to
accept the default location for the program folder.

OfficeSery EasySet ¥3 Setup

Choose Destination Location

Select folder where zetup will install files.

Setup will inztall OfficeS erv EasySet W3 in the following folder.

To inztall to this folder, click Nest. Ta install to a different folder, click Browse and zelect
another falder.

D estination Faolder

L4 \DfficeServ EasySet 3

’ <Back || Mest> |[ Cancel ]

Figure 1.5 Choose Destination Location

6) Then OfficeServ EasySet Setup installs the program files.

OfficeSery EasySet ¥3 Setup

Setup Status

OfficeSery EazpSet Y3 iz configuring pour new saftware installation.

Installing Inztaling Program Files. ..

C:A\netpubhE asyzet_KP3winclose asp

Figure 1.6 Setup Status

Page 1-6 © SAMSUNG Electronics Co., Ltd.
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7) Setup then installs and configures the other components required.

Gathering required information, .,

[FENNRNNRNNRNNRRRR RN RN ] [ 3

Figure 1.7 Install Component

8) Click the [Finish] button, when the installation has completed as shown below.

OfficeSery EasySet Y3 Setup

InstallShield Wizard Complete

Setup hag finished ingtaling OfficeSery EaspSet V'3 on your
cormputer.

Figure 1.8 InstallShield Wizard Complete

© SAMSUNG Electronics Co., Ltd. Page 1-7
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3.3 Supplementary Confirmations

3.3.1 NTFS File System

If the file system is NTFS, some security options have to be changed below:

1) Login to the PC using the Administrator 1D, allowing full access rights.
8] 2) Open Windows Explorer and select [Tools] from the menu bar, then select
[Folder Options].
In the [View] tab, remove the check in the checkbox for the [Use simple file
sharing(Recommended)].

General  Miew | File T_I,Ipesl Ditline Filesl

Folder wigws
Y'ou can apply the view [such as Detailz or Tiles] that

yoL are wzing for thiz falder ta all falders.
-1 |

Apply to All Folders Rezet &ll Folders |

Advanced zettings:

=) Do not show hidden files and Folders :J
{2 Show hidden files and folders
Hide extenszions for known file types
[ Hide protected operating spstem files [Recommended)
Launch folder windows in a zeparate prucess%
Remember each folder's view settings
Restore previous folder windows at logon
Show Contral Panel in by Computer
Show encrypted or compreszed MTFS files in color
Show pop-up dezcrption for folder and desktop tems

O fE:=

gimple file zharing [Fecommended)

—
-
e

Restore Defaults |

k. Canicel I Apply |

Figure 1.9 Folder Options

Page 1-8 © SAMSUNG Electronics Co., Ltd.



OfficeServ EasySet User Guide/Ed.00 CHAPTER 1. Installation of OfficeServ EasySet

3) Then view the [Security] tab in [Properties] of the required folders and files.
This is done by opening the [Properties] window by right-clicking the mouse

button on the “c\\:inetpub\Easyset_kp’ folder.

In the [Security] tab, allow Users to ‘Write’ and ‘Modify as in the example

below:

Easyset_KP Properties ! i S|

Generall Sharing  Security |WEI:| Sharingl Eustu:umizel

Gr-:uup ar Uzel names:

€% NETWORK ]

ﬂ RyuwioongHee [METALGODYRyu WoongHee)
€7 SYSTEM

ﬁ Uzers METALGODA serz]
< |
Add... | Remove |
Permizsions for Users Al Deny
Full Cantral O =
Madify O
Fead & Execute O
Lizt Folder Contents O
Read O
Wirite O ;I

For special permizzions or for advanced settings, e |
click Advanced.

k. I Cancel | Spply

Figure 1.10 Easyset_KP Properties

4) Then restart the 11S Server from the Command Prompt or restart the PC.

F:\>1isreset

Attempting stop

Internet services successfully stopped
Attempting start

Internet services successfully restarted

F:\>

© SAMSUNG Electronics Co., Ltd.
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3.3.2 Windows 2003

If the operating system of Easyset server is Microsoft Windows 2003, some options
have to be changed below:

1) Open [Control Panel > Administrator > Internet Information Service].
8 ] 2) Click [Expand Web Service] at [Local Computer].
3) Set [Active Server Pages] to "Allow".

3.3.3 Windows Vista

If the operating system of Easyset server is Microsoft Windows Vista, some options
have to be changed below:

1. Set Windows features before installing Easyset
1) Open [Start > Control Panel > Programs and Features > Turn Windows features
g2

on or off].
2) Check "ASP" in [World Wide Web Services > Application Development
Features] for ASP service.

(Y Windows Features = €3

Turn Windows features on or off L7}

To turn a feature on, select its check box. To turn a feature off, clear its
check box. A filled box means that only part of the feature is tumed on.

¥| |. FTP Publishing Service -
711 Web Management Tools
= [ |, World Wide Web Services

i Application Development Features 2
NET Extensibility
ASP.NET

cal

ISAPI Extensions
ISAPI Hiters
Server-Side Includes
4 ¥ 1. Common Hitp Features

<

dHEEE

o) [ cone |

Figure 1.11 Windows Vista Properties 1
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3) Check "11S Metabase and 11S 6 configuration compatibility” in [Internet
Information Services > Web Management Tools > IS 6 Management
Compatibility] for virtual directory service.

g

1 Windows Features = |[=
o

Turn Windows features on or off

To turn a feature on, select its check box. To turn a feature off, clear its
check box. A filled box means that only part of the feature is turned on.

B | Internet Information Services
# [¥] J, FTP Publishing Service
= [¥] J. Web Management Tools
=N 05 6 Management Compatibility
v 056 Management Console
4| |, TS6 Scripting Tools
/| . 156 WMI Compatibility
7| | IS Metabase and IS 6 configuration compatibility |
V| . IS Management Console
v II5 Management Scripts and Tools
v IS Management Service

m

[ 0K | Cancel

Figure 1.12 Windows Vista Properties 2

2. Turn off UAC (User Account Control) mode
1) Open [Start > Control Panel > User Accounts > User Accounts].
8] 2) Click [Turn User Account Control on or off] menu.
3) Uncheck "Use User Account Control (UAC) to help protect your computer".
4) Click [OK] button and then PC will be restarted.

=3 Eol B>
@th& <« Turn User Account Contr... - | 4 | | Search 2|

Turn on User Account Control (UAC) to make your computer more secure

User Account Contrel (UAC) can help prevent unautheorized changes to your computer. We recommend
that you leave UAC turned on to help protect your computer,

|D Use User Account Control (UAC) to help protect your computer |

[ QK ] [ Cancel

Figure 1.13 Windows Vista Properties 3
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3. Set authentication of virtual directory

1) Open [Start > Control Panel > System and Maintenance > Administrative Tools
> Internet Information Service (11S) Manager].

2) Select [Web Sites > Default Web Site > Easyset] and click [Authentication] icon.

& Internet Information Services (IS) Manager (===
@,_ y |3 v ADMIN-PC » WebSites » Default WebSite » EasySet » | & 0@ -
File View Help
B & JjeasySetH :
= asyset Home
b 15, /Easy Open Feature
CE PC ( 2 = T
4 & ADMIN-PC (zdimin-PC\ecimin) Ceaini] Ares -E- e R
2 Application Pocls _ B Eplore
3 Wb Site: ASP.MET )
4@ Default Web Site &; “ Fﬂ_ &N Browse Application
& N - 5 2 @1 Browse
NET NET  MET Profile .MET Roles : =
Compilation Glabalization Edit Application
= ; P E sasic Settings...
| include 2 ]
g é'!i L= ab) _’;‘3) Advanced Settings...
MET Users  Application: Connectien  Providers  Session State View Virtual Directories
Settings Strings B DR
® Help
Q..H
SMTP E-mail
s
2llddil[le B [E
ASP Authenticati Default Directery  Error Pages
20,0, |DoCUmENt  Browsing
& = H &
Handler  MIME Types  Modules  SS5L Settings
Mappings
[;j Features View |2 Content View
Ready &
Figure 1.14 Windows Vista Properties 4
&5 Internet Information Services lanager
el Inf 5 S Manag = Eo |
@*,_ [@ v ADMIN-PC + WebSites » Default WebSite » EasySet » | & S e
File View Help
; S Authentication
LE] Disable
T T
DP\/.“IIN PC \:admln PC\admin) Group by: Ne Grouping =
*. [ Application Posls di @ Ho
4.8 Web Sites Iiame tatus B Type =
a @ Default Web Site | Anonymous Authentication Enabled |
B = App_Datz TSFET Impersonation DiEabled
4 -[¥ EasySet Forms Authentication Disabled HTTP 202 Legin/Redirect
7 image
| include
> 5 styles
[= Features View {72 Content View
Configuration: 'lacalhost' applicationHost.config o ract web.config, <location path="Default Web Site/EasySet'> L=

Figure 1.15 Windows Vista Properties 5
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4) Choose "Application pool identity"” and click [OK] button.

Edit Anonymous Authentication Credentials @
Ancnymous user identity:

@) Specific user:

@ Application pool identity |

[ QK l [ Cancel

Figure 1.16 Windows Vista Properties 6
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4  OfficeServ EasySet Environment Settings

This section discusses how to login to set the operating environment.

4.1 Setting the Environment for OfficeServ Link

To execute the OfficeServ EasySet, first OfficeServ Link must be installed and

running.
Setting the Environment for OfficeServ Link
To see the details of the Communication Environment, refer to the OfficeServ Link
NOTE manual.

4.2 Setting the Environment for OfficeServ EasySet

The environment Installation procedures for OfficeServ EasySet are set as follows:

1) To set the IP Address of the PC hosting the OfficeServ Link, click the right-
8 hand mouse button on the Tray Icon as shown below.

|@% 9:11 &M

Figure 1.13 The OfficeServ EasySet Tray Icon

The OfficeServ EasySet Tray Icon

The Tray Icon will be displayed on the Tray Bar while OfficeServ EasySet is
running.

2) Select [Setting] from the drop-down menu.

Page 1-14

Connect System

oetting

Event Viewer

About
Exit

Figure 1.14 Select [Setting]
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3) Set the required IP address in the Setting Panel. This is the IP address of the PC
hosting the OfficeServ Link. The default ports should be retained unless there
is a compelling reason to alter them.

=

% Packet Deliverer - Setting

Web Server-
Listening Port 5004

OfficeSery Link
IP Address ICEEEED
Data Part 5000 | |
SMDR Fort 5002 | |

SHDRA Setting -
Select Country K. =

Auta Connection -
Set Auto Connection ir2

Switch # IP Address State Pazswond
1 165.213.66.138 off 1234
2 165.213.87.63 uli} 1234
3 165.213.110.189 Off 1234
4 1234
5 165.213.11054 On 1234
g 1234
i 1234
g
Save Cancel Exit ‘

Figure 1.15 Packet Deliverer-Setting

The description for the input parameters for the Packet Deliverer-Setting window

are listed below:

Frame Item

Description

Web Server Listening Port

Listening Port No. is used for connecting with the Web Server
OfficeServ Link->Configuration Button->Listen Port No for
Client Connections

OfficeServ Link | IP Address

IP Address of the OfficeServ Link

Data Port

Listen Port No of the OfficeServ Link

SMDR Port

SMDR Port No of the OfficeServ Link
OfficeServ Link->Option Button->Message Monitor/Save
Option>Use SMDR/UCD Msg Monitor->Port No

SMDR Setting | Select Country

Select your Country for the SMDR

Auto Set Auto

Check the checkbox for Easyset to connect to system

© SAMSUNG Electronics Co., Ltd.
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Connection Connection automatically when user excute Easyset.
IP Address, The IP Address and Connection Status of switches to be
State registered in Config Switch Information in OfficeServ Link
Password Input the easyset password as set in the MMC841.
The default password is “1234".
2 Listening Port
If the Listening Port is changed, restart the Packet Deliverer.
NOTE

NOTE

Auto Connection

For Easyset auto connection, OfficeServ Link V3 must be connected to system first.
If OfficeServ Link V3 has not been connected to system during 9 sec, trying auto
connection of Easyset will be stopped.

Page 1-16
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CHAPTER 2
Starting OfficeServ EasySet

This chapter describes the execution procedures for the OfficeServ Link and
OfficeServ EasySet.

1 Executing OfficeServ Link
The execution procedures for the OfficeServ Link are as follows:

1) Start the OfficeServ Link window is activated as shown below.
g2

<L OfficeSery Link ¥3

Connected User List Wiew
Configuration
P &cddress | Port Mo User Type Connect State Connect Time
Configure Lzer
End
£ | #
Matification Message iew
Monitor Opt.
Time Information =
@Feb 18, 2008 10:36... Samsung OfficeSery Link W3 for Multiple Switch Connection SiEhist
[ sumMes
¥ Send s
< |
Syvitch Count 1 Link State Dizconnected Used License u] Total License 15 -

Figure 2.1 OfficeServ Link

2) Click the [Connect] Button to get the Linker to connect to the switch.
The time required to start the OfficeServ Link is about 1~3 Seconds.
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3) When the *All Services are running successfully’ message is shown on the
Notification Message View panel, the OfficeServ Link has started successfully.

“L OfficeSery Link ¥3

Connected User List View
Configuration
IF Address | Port Mo Uszer Type Connect State Connect Time
Configure User

End
£ | >
Matification Message View
Maonitor Opt.

Time Information A

- : - - : S| oswmse
@Feb 18, 2008 10:43. .. Switch Connection Success. [Switch Mo - 5, IP Address - 165 21311054, Port Mo - S002]
@Feb 18, 2008 10:43... Dowwnloading the switch configuration information. please wait. . [+ SUMSG
@Feb 18, 2008 10:43... Switch Connection Successil [V Sendsi
@Feb 18, 2005 10:43... The client connection manager is running successiully.
@Feb 18, 2005 10:43... Al services are running successtully. v

£ | b

Swwitch Count 1 Link State 1 Uzed License u] Total License 15 -

Figure 2.2 OfficeServ Link_Connect

The OfficeServ Link manual should be consulted to setup and configure the
OfficeServ Link clients.

OfficeServ Link License

5)
/’4?7 In OfficeServ Link License, Easyset service has to be enabled.
L NOTE

1 OfficeServ Link User List
’/‘?7 Easyset server has to be registered in User List of OfficeServ Link.
L NOTE
1 OfficeServ Link Switch Information
’4‘?)’ Confirm the Switch list and connection status in OfficeServ Link. Easyset will
NOTE connect to the connected switches.
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2 Executing OfficeServ EasySet
The execution procedures for the OfficeServ EasySet are as follows:

1) Double click the EasySet icon on the desktop and then the EasySet Tray Icon is
9 created as shown below.

|@% 2:11 AM

Figure 2.3 The OfficeServ EasySet Tray Icon

OfficeServ EasySet Auto Connection

If auto connection was set and it is done succesefully, user can skip the next steps
NOTE for connection.

2) Click the right-hand button of the mouse on the tray icon and select the
[Connect System] option.

Disconnect Systen
Seting

Event Yiewer
About

Exit

Figure 2.4 Connect System

3) Input the password and click the [OK] button.

w Input Password

Switch # IP Address Pazsword
5 165.213.110.54

Close
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Figure 2.5 Input Password

% OfficeServ EasySet Password
The password for OfficeServ EasySet is the system password as set in the

NOTE MMC841.The default password is 1234.

4) If the Tray Icon is displayed as shown below(with joined chain links), then
OfficeServ EasySet service has started successfully.

B 10143 aM

Figure 2.6 The OfficeServ EasySet Tray Icon__joined chain links
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CHAPTER 3
Using OfficeServ EasySet

This chapter describes how to login and how to use the menus of the OfficeServ
EasySet.

1 Logging into OfficeServ EasySet
The login procedure for the OfficeServ EasySet is as follows:

1) Activate Microsoft’s Internet Explorer so that it can be used as the user
9 interface for the login and configuration.

2) After starting the web browser, the address of the OfficeServ Easyset Server
will need to be entered-this can be done by either entering the server’s IP
address or the server name. You will need to determine these before connecting
to the server.

From Internet Explorer enter the URL address of the installed program into the

URL input field and press the [Enter] key.
(e.g) http://localhost/EasySet OR http://<Server IP address>/EasySet
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3) When successfully connected to the OfficeServ EasySet, the default page will

be activated as below:

F@ http:#/166,213,87 194/zasyset /

3

H&®@|

wmmomcs

Select a language | English + | [

Figure 3.1 OfficeServ EasySet
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4) Select the required language via the dropdown box and press the [Go!] button.
The login page will be activated as below:

|21 htp:7165,213,87,194/ default?, asp ~ |

KEYPHONE PROGRAMMING

Input 'Station Number' and ‘Password', and click ‘Login’ button.

5-165.213.110.54 ~

.

Black

Figure 3.2 Login
5) Select Switch Number and enter your Station Number and your

password(default is 1234). Choose the parameters relating to your phone-color,
LCD or no LCD, and then click on the [Login] button.

© SAMSUNG Electronics Co., Ltd. Page 3-3



CHAPTER 3. Using OfficeServ EasySet OfficeServ EasySet User Guide/Ed.00

6) The following main page will be displayed. The type of keyset in the browser
panel will correspond to the keyset used at your station.

@ hitp://165,213,87 194/easyset /main,asp v|

OS EasySet _ ' _ GERT

SAMSUNG

Station Lock
Unlocked
Call Forward

Cancel Forward

Station Name

Pgm Message

Figure 3.3 Main page

Click the ] button then the following additional menus will be displayed.

Wallhoard @ Zall Accounts

(8] Logout

Figure 3.4 Menu
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2 Using the OfficeServ EasySet

This section describes how to use the menus related to the OfficeServ EasySet.

2.1 Station Lock

This feature allows you to lock your station against unauthorized use during your

absence.

The station lock feature may not be available to you, based on the Class Of Service
allocated to your station. Please refer to your System Administrator.

Select the [Station Lock] menu from the main page, then the <Station Lock>
window appears as below:

o init
pith this mode

tation not to be used during abs

It station lock is not allowed in C ice, it can be

Figure 3.5 Station Lock

After selecting one of the three option radio buttons, click the [Set] button.

Item Description
Unlocked Unlock a locked station
Locked Out Prevent access to the external trunk lines to make telephone calls. However,
answering incoming calls is still possible
Locked All Prevent calls from being made or received at your station
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2.2 Password

Your station password is used to login to the OfficeServ EasySet and change the
various program settings for your station. The default value is '1234".

Be sure to change your password to protect your program settings. If you forget
your password, ask your System Administrator to reset your password to the default
password.

Select the [Password] menu from the main page, then the <Change Password>
window appears as blow.

Input a new password in the first field and then retype the same new password
again in the second field to confirm it. Finally, click the [Set] button to change to
the new password.

o login of program i nd the

ord to protect your informatio

Figure 3.6 Change Password

Page 3-6 © SAMSUNG Electronics Co., Ltd.



OfficeServ EasySet User Guide/Ed.00 CHAPTER 3. Using OfficeServ EasySet

2.3 Call Forward

This allows you to program the call forward destinations for your station.

The forward destinations can be internal stations, station groups, or external numbers
The Forward feature or forwarding to external numbers may not be available to you,
based on the Class Of Service allocated to your station. Please refer to your System
Administrator.

Select the [Call Forward] menu from the main page, then the <Call Forward>
window will be displayed as given below. After inputting the call forward type(the
Assigned Feature) and telephone number, click the [Set] button.

When programming to external numbers insert the trunk access code before entering
the telephone number.

Call Forward Tyvpe Tel No

 Forvard conce! I

Call forward is not to be activated or canceled.

Al call is forwarded,

are talking over the telephone, & new call is

ChosworerForers | [ ] |

When vou are not answer, the call is forwared,

" Bugv/Modnswer Forward

er the telephone or not al

Coototistrd forwora | [ ]|

Whi e wou s set to OND state, the call is

Figure 3.7 Call Forward
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2.4 Station Name

This allows you to enter an 11-character string name for display to an internal party
calling from an LCD station.

Select the [Station Name] menu from the main page, then the <Station Name>
window will be displayed as given below. Input the required station name, and then
click the [Set] button.

T Station Name

Figure 3.8 Station Name
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2.5 Speed Dial

This allows you to program personal speed dial locations for your station.

Each station may have up to 50 locations(or bins) assigned to it - these speed dial
bins are numbered 00~49.

Select the [Speed Dial] menu from the main page, then the <Speed Dial> window
will be displayed as given below. After inputting the speed dial name and telephone
number, click the [Set] button.

Each speed dial number consists of a trunk or trunk group access code and up to 24

digits to be dialed. These dialed digits may consist of 0~9, * and #.

You can also program an 11 character string name for each speed dial number.

© SAMSUNG Electronics Co.,

Ltd.

2 Menu Page - Microsoft Internet Explorer

EASY SET

B Speed Dial

Speed Mame Tel Ho
o I I
- I
+ I
> I
¢ I
" I
° I

Figure 3.9 Station Speed Dial

Page 3-9



CHAPTER 3. Using OfficeServ EasySet OfficeServ EasySet User Guide/Ed.00

2.6 Date Display

This allows you to select the date and time display mode on your station LCD.

Select the [Date Display] menu from the main page, then the <Date Display>
window will be displayed as given below.

There are two option formats for the Date : Format 1(MM/DD DAY HH:MM), and
Format 2(DAY DD MON HH:MM)

There are also two option formats for the Time : 12 Hour and 24 Hour

The character format can be either Upper Case or Lower Case.

 Oriental = Yestern

Time 12 Hour & 24 Hour

" lpper case & Lower case

select the date and time display mode-on

A HHMY and

Figure 3.10 Date Display
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2.7 PGM Message

This allows you to set or cancel a programmed message.
Programmed messages can be used to advise of your status to internal callers to

your station. The programmed message will appear on their station LCD.

Up to 15-programmed messages are available system wide and 5 personal messages

can be programmed. Each message can be a maximum of 16 characters.

Select the [PGM Message] menu from the main page, then the <Programmed Message>
window will be displayed as given below. After selecting one of the radio button options,

click the [Set] button.

@ Programmed Message

& fancel Message

' RIVE ME

THE GALL | € TAKE # MESSAGE

7 ASK THEM TO HOLD

" SEMD TO

MY YH © TRIF TO Wy SEC

" LEAVE 4 MESSAGE

" PAGE ME

0 0UT OF TOWN

' IN & MEETING

| WILL CALL BACK | € Blank Message

' Blank Message

' Blank tessage

You can change these messages.

" Blank Message ° Blank Message

¢ | Blank Messzage

'8 | Blank Message |

¢ | Blank Message

¢~ | Blank Message

o bizat Frew, flext Lest P

¢ | Blank Message

Figure 3.11 Programmed Message
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2.8 Alarm

This allows you to set or change the alarm clock/appointment reminder feature.
Up to 3 different alarms are available.

Each alarm can have a message of up to 16 characters. The alarm message is
displayed on a station LCD when an alarm rings.

Select the [Alarm] menu from the main page, then the <Alarm Reminder> window
will be displayed as given below.

There are three Alarm settings: NotSet, Today, and Daily.

EASY SET

Alarm Reminder

Alarm Hour- Min ge

pointrment

Figure 3.12 Alarm Reminder
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2.9 Send MSG

This allows you to send a message to another station user.
The maximum length of a message is 80-characters.

There are four menus in the [Send MSG] menu, which are Message, Inbox, Outbox,
and Depository.

2.9.1 Message

Select the [Send MSG] menu from the main page, then the <Message> window will
be displayed as given below. After inputting the intercom call number and message,
click the [Send] button.

ft Internet Explorer

=/ Message 4o Inbox  E¥-Qutbox  E=aDepository

Tel Mo

Recipients

Hessage

to leave & ge to the other keyphone
User.
The number of new s displayed on LCD of the
phone,

Figure 3.13 Message

If the INFDSP key of the received phone is set to ‘ON’, the latest received message
will be displayed on the LCD of the phone.

You can assign an INFDSP key to the key extender by clicking the extend button in
the EasySet. The assigned INFDSP key is a toggle button.
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2.9.2 Inbox

Select [Send MSG]->[Inbox] from the main page, then the <Inbox> window will

be displayed as given below.
You can see up to twenty received messages in the Inbox.

=7 Message e Inbox B Outbox  [E=1Depository

Hessage Date

[Thank voo very much~ =]

03/05/16 | man
2008

||

Hi everyone~~!1 =~/ 4]

03/0516 | man
2008

|

Figure 3.14 Inbox

To delete messages, check the relevant message boxes and click the [Delete] button.
To save a message in the Depository, click the [Dep] button corresponding to the
message.
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2.9.3 Outbox
Select [Send MSG]->[Outbox] from the main page, then the <Outbox> window

will be displayed as given below.
You can see up to ten sent messages in the Outbox.

=/ Message 4o Inbox B Qutbox  E=1 Depository

Message Date
rhank you very much~

03405416 | _
20: 08

Hi everyone~~l1 ~*/ :
03405416
20:08

Figure 3.15 Outbox

To delete messages, click on the relevant message box and then click the [Delete]
button.

To keep a message in the Depository, click the [Dep] button corresponding to the
message.

To cancel a sent message, click the corresponding [Off] button of the message.
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2.9.4 Depository

From the main page, select [Send MSG]->[Depository]. Then the <Depository>
window will be displayed as given below.
You can view up to ten kept messages in the Depository.

Internet Explorer

EASY SET

© Message % Inbox  EE-Qutbox  B=1Depository

Meszage

Hi everyone~~l1 "~/

Thank wou wery much~

Figure 3.16 Depository

To delete messages, click on the relevant message box and then click the [Delete]

button.

To add a message to the Depository, input the message and click the [Add] button.
To modify a message, edit the message and click the corresponding [Mod] button.
To send a kept message to someone, click the corresponding [Msg] button.
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2.10 Answer Mode

This allows you to change the answer mode for intercom calls to your station.

From the main page, select the [Answer Mode] menu. Then the <Answer Mode>
window will be displayed as given below. After selecting the required answer mode
and the required executive answer mode, click the [Set] button.

S LEER Auto Answer Mode -

il ring in one of eight custom ring

v hnde ! The keueet will autamaticall a

Figure 3.17 Answer Mode

The following options are available:

Answer Mode Description
Ring Mode The phone will ring in one of eight customisable ring patterns.
Auto Answer The phone will automatically answer calls on the speakerphone after giving a
Mode short attention tone.

Voice Announce The phone will not ring. After a short attention tone, callers can make an

Mode announcement but the ANS/RLS key or handset must be used to answer calls.
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2.11 Stn On/Off

This allows you to set any of the following station features:

From the main page, select the [Stn On/Off] menu. Then the <Station On/Off>
window will be displayed as given below. After selecting the required assign

features, click the [Set] button.

} Menu Pag

st seT

& Station On/OF

Auto Hold

|0

Auto Timer

Headset Use

|0

Hot Key Pad

Kew Touch Tone

<

Page Re-Jain

<l

Ringaing Preference

<

Call Cost Display

Auto Camp-0n

AME EGH

AME Password

Display Speed Mame

d|o|ojo|o

Figure 3.18 Station On/Off
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All the “assign features’ on the [Station On/Off] menu are listed in the table below
with their corresponding descriptions.

Assign Feature

Description

AUTO HOLD Automatically places an existing external call on hold if a CALL button, trunk
key or trunk route key is pressed during that call.
AUTO TIMER Automatically starts the stopwatch timer during an external call.

HEADSET USE

When on, this feature disables the hook switch, allowing a headset user to
answer all calls by pressing the ANS/RLS button.

HOT KEYPAD When on, this feature allows the user to dial numbers without having to first lift
the handset or press the SPK button.

KEY TOUCH Allows you to hear a tone when pressing buttons on your station.

TONE

PAGE REJOIN Allows you to hear the latter part of page announcements if you become free
during a page.

RINGING When off, you must press the fast flashing button, after lifting the handset, to

PREFERENCE | answer a ringing call.

CALL COST When on, the cost of the call in progress will show in the upper right corner of

DISPLAY the station display instead of the duration of the call.

AUTO CAMPON

When on, allows you to automatically camp on to busy stations by remaining
off-hook, without needing to press a CAMP-ON key.

AME BGM When on, allows you to hear background music(BGM) instead of your personal
mailbox greeting that your callers hear when the Answer Machine Emulation is
activated. This requires a Samsung Voicemail card and a BGM source
programmed for your station.

AME If this option is set to YES, you must enter your station password to set the

PASSWORD Answer Machine Emulation on your station.

DISPLAY When on, the speed dial name associated with a speed dial number is

SPEED NAME displayed on your station’s LCD display when using the speed dial. Available
only on iDCS500-L.

CID REVIEW When on, saves information on all calls that ring at an extension. When OFF,

ALL saves information only on calls that were not answered at the extension or by
the voice mail. Available only on iDCS500 or OfficeServ-L systems.

SECURE OHVA | When on, an OHVA announcement from another station will only be heard
when you are using the handset. When off, OHVA announcements will only be
heard over the station speaker. Available only on the iDCS500 and
OfficeServe-L systems.

STOP CID When off, the Caller ID will be continued to be displayed after you answer an

DISPLAY external call.

AUTO ANSWER | Automatically answers an incoming external call.

TRUNK

© SAMSUNG Electronics Co., Ltd.
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Volume

This allows you to set the volume and the ring tone heard at your station. You can
use the Volume Up/Down buttons to vary the volume levels during a call.

From the main page, select the [Volume] menu. Then the <Station Volume>

window will be displayed as given below. After selecting the required volume of
each assign feature, click the [Set] button.

Internet Explarer

1§) Station Volume

Ring Volume

Off Hook Ring Yolume

Handset Rx Yalume

Speaker Phone Yolume

BGM Speaker Yolume

Page Speaker Yolume

Ring Frequency

e[ Cancel [ Cisse

Figure 3.19 Station Volume
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All the “assign features’ on the [Station Volume] menu are listed in the table below
with their corresponding descriptions.

Assign Feature Description

RING VOLUME This is the volume setting for the station ringer. There are eight
volume levels : level 1 is the lowest and level 8 the highest.
OFF HOOK RING VOLUME This is the volume of the alert tone that tells you there is a call
camped on to your station. There are eight volume levels.
HANDSET RX VOLUME This is the volume level received by you from the other party
during conversations on the handset receiver. There are eight

volume levels.
SPEAKER PHONE VOLUME This is the volume level received by you from the other party
during conversations on the station’s speaker. There are 16

volume levels: level 1 is the lowest and level 16 the highest.
BGM SPEAKER VOLUME This is the volume of the background music heard over the
station speaker when your station is idle and BGM is turned on.

There are 16 volume levels.
PAGE SPEAKER VOLUME This is the volume you will hear when an internal page call is
made over the station speaker when your station is idle and the

PAGE is turned on. There are 16 volume levels.

RING FREQUENCY This is the ring tone heard at your station to alert you to incoming
calls.
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2.13 Text Msg

This allows you to set or change text messages for use during an OHVA call to your
station.
This feature must be enabled for you by the System Administrator.

The System Administrator can establish the internal stations in the ‘MMC611
TEXT MSG STN’.

From the main page, select the [Text Msg] menu. Then the <Text Message>
window will be displayed as given below. After inputting a text message, click the
[Set] button.

A maximum of 10 Text Messages are allowed per station. Each can be 16 characters
long.

Gk Vesssge
| EEET—

Blank Message

5

i}

= Blank Message
Jil| Blank Message

Figure 3.20 Text Message
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2.14 Conference

This allows you to set or change the dispatch conference groups.

Only users designated by your System Administrator can use this function.

The System Administrator can establish the internal stations in the ‘MMC612 GRP
CONF STN’.

Once programmed, you can establish a conference call with the available members
of the group automatically. Refer to your Station User guide for details on how to
make the group conference call.

From the main page, select the [Conference] menu. Then the <Conference Group>
window will be displayed as given below.

Each group can have an associated 11 character name and up to 4 members.

You can have a maximum of 5 Conference Groups.

Internet Explorer

Menbers

Hame

Hembers

Menbers

Henbers

Figure 3.21 Conference Group
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2.15 Caller ID

This allows you to set your preference for the way Caller ID is displayed on your
station LCD.

From the main page, select the [Caller ID] menu. Then the <Station CID Display>
window will be displayed as given below. After selecting one of the CID Display
radio button options, click the [Set] button.

%2 station CID Display

" Mo Display
(LN E=E 0N (' Nunber First
& Name First

t the individual station display

/ Mumber First! Name First

Figure 3.22 Station CID Display

Refer to your System Administrator to check whether the Caller 1D is available on
your system.
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2.16 LCD Display

If your station has a large LCD, this function allows you to set or change the LCD
screen type in standby mode, and the way that it identifies the other stations
programmed in the Programmable Features screen.

From the main page, select the [LCD Display] menu. Then the <Large LCD

Display> window will be displayed as given below. After selecting the idle screen
type and DSS key display radio buttons, click the [Set] button.

@ galender € Information

& Mmber O Mame

Figure 3.23 Large LCD Display
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2.17 Language

This allows you to assign the language used on your station’s LCD display.
From the main page, select the [Language] menu. Then the <Station Language>

window will be displayed as given below. After selecting the required station
language, click the [Set] button.

‘j; Station Language

Station Language [EEEEHTSI S Clt=o=TR e

d on user's

Figure 3.24 Station Language
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2.18 Exec State

If your station is designated a ‘Boss’ station this feature enables you to set or
change your status or to set a reason for your absence.

Only a “‘Boss’ station user can program this function.

The System Administrator can establish the internal stations in the ‘MMC303
BOSS/SECT’

The state of each ‘Boss’ station is displayed in the Wallboard feature and is
refreshed every minute.

From the main page, select the [Exec State] menu. Then the <Executive State>

window will be displayed as given below. After selecting one of the options, click
the [Set] button.

* In the room

' In & meeting
Movel Inside)  Internal

Choe [ ]

C out of town

" Gone home
 shart term trip
 Long term trip

Outd outside)

00 vacation

Cot[ ]

Figure 3.25 Executive State
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2.19 Schedule

This allows you to set or modify scheduled events. A scheduled alarm will ring at
your station based on the time set in the OfficeServ EasySet Server.

2.19.1 Add/Delete Schedule

From the main page, select the [Schedule] menu. Then the <Schedule> window
will be displayed as given below.
A maximum of 10 scheduled items can be programmed.

4| 2003/5/16(Fri) |

SO LT | RS

Title Flace

1152 3 I Conference conf room

4 5 B 7 8 910 ™ Lunch 0K Fest,
11 12 13 14 15 16 17
18 1920 21 22 23 24

25 26 27 28 20 30 3

Figure 3.26 Schedule

You can:

e Addaschedule : Select a required date to add a schedule in and click the [Add]
button.

¢ Delete a schedule ;: Check the checkbox for the schedule to be deleted and click
the [Delete] button.

* View a schedule : Select the required date and click the Schedule Title to view
the details.
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2.19.2 Edit a schedule

Edit a schedule : Select the required date and click the Schedule Title to view the
details. After editing, click the [Save] button.

| 2003/5/16(Fri) |

S| UL T RS

‘Conference

1] 224 23

‘conf room
44 53 B 7 28 Syl

> 2003-05-16
11 12 13 14 15 46 17

18 18 20 21 22 23 24 :

25 26 27 28 28 30 3 3

Conference for Easyset[!

Content

Figure 3.27 Schedule_Edit
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2.20 Wallboard

This allows you to view the status of the designated Boss stations.
The function may not be programmed on your OfficeServ system. Please refer to
your System Administrator.

From the main page, select the [Wallboard] menu. Then the <Wallboard> window
will be displayed as given below.

Figure 3.28 Wallboard

You may also remove or include ‘Boss’ stations viewed with this feature.

To remove a station from the viewed Boss group, click the [Show Group], then
select the station you wish to remove and click Group.

To return the station to the Boss group click [Show All], then select the station to be
added and click Group. This function is a view-only feature.
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2.21 Call Accounts

This allows you to view the details of your recent telephone calls, numbers, times,
dates, durations, etc. Refer to your System Administrator to establish that this
feature has been made available to you.

From the main page, select the [Call Accounts] menu. Then the <Call Accounts>
window will be displayed as given below.
It displays incoming calls with 'In" and outgoing calls with ‘Out’.

Figure 3.29 Call Accounts
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ANNEX A
FAQ

Q1) When | double click the EasySet icon on the desktop, the error message
‘Please change the Listening Port No’ is reported.

ANS)  The Listening Port No that is connected to the web server OfficeServ
EasySet was already executed. After clicking the right-hand mouse button
on the Tray Icon, select the [Setting] menu. Change the value for the
[Listening Port] field in the Packet Deliverer-Setting window.

Q2) When | access OfficeServ EasySet, the error message ‘Packet Deliverer
has already run.” is reported.

ANS)  OfficeServ EasySet was already executed. You can see the Tray Icon of
OfficeServ EasySet in the tray bar.

The Tray Icon of OfficeServ EasySet is connected to the system : &
The Tray Icon of OfficeServ EasySet is not connected to the system : ¥y

Q3) When | access OfficeServ EasySet, the error message ‘Database file was
not found.” is reported.

ANS)  Database files were moved or deleted. Database files being used in
OfficeServ EasySet have to be in the setup folder.
If you cannot find the DB files, please repair or reinstall the OfficeServ
EasySet program.
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Q4)

ANS)

Q5)

ANS)

Q6)

ANS)

Q7)

ANS)

Q8)

ANS)

Annex A-2

The [Connect System] menu from among the pop-up menus is not
activated.

This is the state in which OfficeServ EasySet cannot connect to
OfficeServ Link. Confirm that OfficeServ Link has been executed

and connected to the system and confirm that the IP address of

OfficeServ Link is correct in the [Setting] window from among the pop-up
menus.

When | click [Connect System] and input a password, the error message
‘Password is wrong. Please try again.’ is reported.

You can find the password from the [EASYSET OPTION PSWD] option
of [KeyMMC #841 SYS IP OPTN].

When | execute [Connect System], the error message ‘Data download was
failed. Please try again.’ is reported.

It is an error that occurs when initial data is downloaded from the system.
Confirm that the version of OfficeServ EasySet is able to run on your
system if the state is preserved. OfficeServ EasySet is available on
OfficeServ systems.

I accessed the web server of the OfficeServ EasySet at the IE browser and
then an error message “The page cannot be displayed.” was reported.

This is a state in which the web server does not operate normally.
OfficeServ EasySet should be served with the 11S(Internet Information
Server). Confirm that IS is installed and activated.

If 11S is not installed then refer to the [installation of 11S] part of this
manual. Or restart the 11S or restart the PC.

I logged into EasySet at the IE browser and then an error message “Socket
Connect Timeout’ was reported.

This is a state in which the OfficeServ EasySet is not activated. You
should execute the OfficeServ EasySet and connect to the system first.
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Q9)

ANS)

Q10)

ANS)

Q11)

ANS)

I logged into EasySet at the IE browser and then an error message ‘The
request couldn’t be delivered to the system.” was reported.

The connection between the system and OfficeServ EasySet was cut off.
Confirm the connection states between the system and OfficeServ Link
and between OfficeServ Link and OfficServ EasySet. Refer to [CHAPTER 4
Starting OfficeServ EasySet] of this manual for connecting.

I logged into EasySet at the IE browser for the first time and it is not a
duplicate state, but an error message ‘[Login Duplicate] The other user
logged in this station no.” was reported.

Using the database files by web users has been limited by the security
options. Refer to [Supplementary confirmation] of [CHAPTER 2 Installation
of OfficeServ EasySet].

During using OfficeServ EasySet, an error message ‘It is not available to
you, based on the Class Of Service allocated to your station.” was reported.

Your phone was restricted by the Class Of Service(COS). Only the system
administrator can change the COS.
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ABBREVIATION

CTI
G

GUI
I

IS
L

LCD
M

MMC
O

oS
P

PBX
T

TCP/IP

Computer Telephony Integration

Graphical User Interface

Internet Information Server

Liquid Crystal Display

Man-Machine Code

Operation System

Private Branch eXchange

Transmission Control Protocol/Internet Protocol
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